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Warnings and Cautions

Note and Safety Information

We use caution and warning statements throughout this book to drawyour attention to important
information.

Warning! Caution!
This statement appears with information that ~ This statement appears with information that is
is important to protect people and equipment  important for protecting your equipment and
from damage. Pay very close attentionto all ~ performance. Read and follow all cautions that
warnings that apply to your application. apply to your application.

L

Warning! Agency approval for hazardous location installations varies between flow meter models. Consult the flow meter
nameplate for specific flow meter approvals before any hazardous location installation.

Warning! All wiring procedures must be performed with the power off.

Warning! To avoid potential electric shock, follow National Electric Code safety practices or your local code when wiring this unit
to a power source and to peripheral devices. Failure to do so could result in injury or death. All AC power connections must be in
accordance with published CE directives.

Warning! Do not power the flow meter with the sensor remote (if applicable) wires disconnected. This could cause over-heating of the
sensors and/or damage to the electronics.

Warning! Before attempting any flow meter repair, verify that the line is de-pressurized.

Warning! Always remove main power before disassembling any part of the mass flow meter/controller.

Caution! Before making adjustments to the device, verify the flow meter/controller is not actively monitoring or reporting to any
master control system. Adjustments to the electronics will cause direct changes to flow control settings.

Caution! When using toxic or corrosive gases, purge the line with inert gas for a minimum of four hours at full gas flow
before installing the meter.

Caution! The AC wire insulation temperature rating must meet or exceed 80°C (176°F).

Caution! Printed circuit boards are sensitive to electrostatic discharge. To avoid damaging the board, follow these
precautions to minimize the risk of damage:

o before handling the assembly, discharge your body by touching a grounded, metal object
o handle all cards by their edges unless otherwise required
o when possible, use grounded electrostatic discharge wrist straps when handling sensitive components



Receipt of System Components

When receiving a Sierra mass flow meter, carefully check the outside packing carton for
damage incurred in shipment. If the carton is damaged, notify the local carrier and submit a
report to the factory or distributor. Remove the packing slip and check that all ordered
components are present. Make sure any spare parts or accessories are not discarded with
the packing material. Do not return any equipment tothe factory without first contacting
Sierra Customer Service.

Technical Assistance

If you encounter a problem with your flow meter, review the configuration information for
each step of the installation, operation, and setup procedures. Verify that your settings
and adjustments are consistent with factory recommendations. Installation and
troubleshooting information can be found in the SmartTrak 100 Series manual.

If the problem persists after following the troubleshooting proceduresoutlined in the
SmartTrak 100 Series manual, contact Sierra Instruments by fax or by E-mail(see inside
front cover). For urgent phone support you may call (800) 866-0200 or (831) 373-0200
between 8:00 a.m. and 5:00 p.m. PST. In Europe, contact Sierra Instruments Europe at +31
(0)72-5071400. In the Asia-Pacific region, contact Sierra Instruments Asia at +86-21-
58798521. When contacting Technical Support, make sure to include this information:

e The flow range, serial number, and Sierra order number (all marked on
the meter nameplate)
e The software version (visible at start up)
The problem you are encountering and any corrective action taken
e Application information (gas, pressure, temperature and piping configuration)


https://test.www.sierrainstruments.com/userfiles/file/manuals/100-instruction-manual.pdf
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Chapter 1: Introduction

This manual will explain how to add a Sierra flow meter or controller equipped with Profibus DP to
your network. This interface allows access to all relevant data available in the flow meter.

Set Up Quick Step Plan

To successfully add the flow meter to a Profibus DP network you need the following:
e Profibus network with a DP master

GSD file

Bitmap files

Connection cables

Power supply (for the flow meter)

Setup steps:

e Load GSD
Copy bitmaps
Add slave device to system
Set slave configuration
Set slave station address
Download configuration
Test configuration



Chapter 2: Field Bus Installation

Al electrical connections for your SmartTrak® Instrument and Profibus DP are made on the left (inlet)
side:

Power “On”
Green Light

CATS

Connector
(Pilot Module)

Profibus DP
Connector

15-Pin D
Connector

Note: The CAT 5 connector is not an Ethernet connector

Fieldbus Connector

The Profibus DP network is connected to the Profibus DP using an approved Profi-DP DB9 connector.
The connector has the following pin configuration:

4_ NC
PBSV — 1 O 3
NC e .
8 (3)_— PB-B (red)
PB-A(green) — 1O 4
9 O——— NC
NC — 1O ¢
\O—— PB-GND



Cable

Profibus cables are shielded twisted-pair copper cables which differ from each other in the type of
wire (fixed/flexible) and/or sheath. The two inner cores of a Profibus cable have green and red
insulation. The specifications in this chapter are primarily intended to provide a general introduction
and describe the cable properties to be considered (see also IEC 61784-5-3). A Profibus wiring guide
can be found at: http://verwertraining.com/wp-content/uploads/InstallationGuideV9_2.pdf

The cable must conform to the following specifications:

Impedance: 150 Ohm (nominal) at frequencies from 3 to 20 MHz.
Cable capacitance: < 30 pF per meter.

Core diameter: > 0.34 mmz, corresponds to AWG 22.

Cable type: twisted pair cable. 1x2 or 2x2 or 1x4 lines.

Resistance: < 110 Ohm per km.

Signal attenuation: max. 9 dB over total length of line section.
Shielding: CU shielding braid or shielding braid and shielding foil.
Max. Bus length: 200 m at 1500 Kbit/s, up to 1.2 km at 93.75 Kbit/s.

Termination

The Profibus physical layer is based on RS-485, and therefore termination resistors are needed at both
ends of the network. Many Profibus DB 9 connectors have built-in switchable terminators that can be
powered from the Profibus DP. The schematic below shows the internal wiring of a terminator:

+ 5V —
line B ———

line A 1'

3900

2200

3900

ground —T

Status LEDS

The interface has two multi-color LEDs mounted on top of the enclosure to indicate the status.

“UACTIVE @ @ NET

The left LED is used to show the status of the interface the right LED shows the network status.


http://verwertraining.com/wp-content/uploads/InstallationGuideV9_2.pdf

Status LED

Status Description

Flashing green/red | Initializing

Steady green Device operational

Flashing red Recoverable hardware failure

Steady red Hardware failure — attention required
Network LED

Off Not online — waiting for configuration
Steady green Data exchange

Flashing red Connection lost

Slave Address

The Profibus DP slave address of the interface can be set. Default instruments will be delivered with
slave address 126 (all DIP switches to off). This address has been agreed by the PROFIBUS
organization to be free for installing new devices to the bus. Changing the station address is done in
two ways, either through a dip switch or through the master.

Dip Switch

The dip switch is located on the right side of the interface. Remove the cover to expose the switch:

The dip switch is binary encoded with the LSB (lowest bit) on the left side. The switch is only read
during power-up.




The switch becomes active when the slider is moved upwards. Here some examples of some addresses
(1 = on/up, 0 = off/down):

Address | Dip Switch #
ID 12345678
1 1/0]0]0J0J0J0]0

14 | 0|2[1/2/0j0[0j0

60 | 0[0[1|L[Z[L/0j0

125 | 10[1/11/L[Z[0

Note: An address set with the dip switch has the highest priority and the slave address will use this
address when powering up!

Server Assigned Address

It is possible to change the address of the unit through the server. Perform the following steps to
change the address:

1. Assign a new address from the server
2. Set the dip switch to 128 (pin 8 on) or higher.

The assigned address will be used each time that the unit is powered.

Set Address (126)

It is possible to force the address of the unit to 126. Set the dip switch to zero and power cycle the unit.
The address is set to 126. The address can be changed by the Master if needed. Do keep in mind that if
the dip switch remains set to zero, the address will be set to 126 at each power-up.

10



Chapter 3: Configuration

GSD File

Each Profibus DP instrument comes with its own GSD-file. The GSD file contains the instrument
specifications telling the master configuration software which facilities/features the instrument offers
to the Profibus system. The GSD file can be download from
http://www.sierrainstruments.com/userfiles/file/SIEROE12.GSD .

The GSD-file is a text-file containing:

Identification info:
o Model name: “SmartTrak 100S - Profibus”
Vendor name: “Sierra Instruments Inc.”
Identification number: 0x012E
Bitmap device: “100S_dev”
Bitmap diagnostics: “100S_dia”
Bitmap SF: “100S_spf”
(Bitmap files are used in configuration software to indicate instrument status)
¢ Revision numbers
e Hardware characteristics:
o VPC3+C dependable properties
e Software characteristics:
o Supported features of Profibus: Freeze, Sync, auto baud rate detection
e Maximum bus data lengths
e Size of used data buffers

O 0O O O O

Cyclic Data Overview

The following table shows the cyclic input & output buffer supported by the device. The cyclic data is
in 2 Modules. Module 1 has 32 bytes in of process data in, and 24 bytes out. Module 2 has 14 bytes in
of device info. The actual data address will depend on preceding devices on your bus. The matrix
example below shows the actual data addresses, assuming the Profibus DP is the first device on your
Profibus network.

Incoming Cyclic Data (Module 1 slave to master)

Data Description Size Format
Address (bytes)

0 Flow 4 REAL
4 Set point 4 REAL
8 Valve mode 2 INT
10 Valve power 2 INT
12 User full scale 4 REAL
16 Factory full scale 4 REAL
20 Flow unit 2 INT
22 Set point source 2 INT
24 Gas span 4 REAL
28 Gas index 2 INT
30 Status 2 INT

32 bytes

11



https://test.www.sierrainstruments.com/userfiles/file/SIER0E12.GSD

Outgoing Cyclic Data (Module 1 master to slave)

Data Description Size Format

Address (bytes)
0 Set point 4 REAL
4 Valve mode 2 INT
6 User full scale 4 REAL
10 Flow unit 2 INT
12 Set point source 2 INT
14 Gas span 4 REAL
18 Gas index 2 INT
20 Zero unit 2 INT
22 Factory reset 2 INT

24 bytes

Device info: (Module 2 master to slave)

Data Description Size Format

Address (bytes)
32 Serial number 8 ASCII
40 Device type (set to 100) 2 INT
42 Firmware revision 4 REAL

14 bytes
Cyclic Data Explained
Flow (R):

Data type: 32 bit floating point also called REAL (LSB — MSB)
Description: The flow as measured by the instrument

Set Point (RIW):

Data type: 32 bit floating point (LSB — MSB)

Description: When using a controller the set point is shown. Writing to this register will set the set
point. When a set point is entered which is beyond the full scale of the instrument then the set point
will be changed automatically to the full scale value.

User Full Scale (R/W):

Data type: 32 bit floating point (LSB — MSB)

Description: The user full scale value allows you to re-range the instrument. Any value between 50%
and 100% of the factory full scale is allowed. The new value will also redefine the analog outputs of
the instrument (when used). The 20mA/5 VDC will represent the new full scale value.

Factory Full Scale (R):
Data type: 32 bit floating point (LSB — MSB)
Description: Factory full scale value of the instrument.

Valve Mode (R/W):

Data type: 16 bit integer
Description: Mode at which the valve of the controller will operate. The table shows the available
values:

Value Mode
1 Automatic
2 Closed
3 Purge

12




Valve Power (R):

Data type: 16 bit integer
Description: Value representing the power injected into the value (when using a controller). The value

will range between 0 and 3200 (4095 when purging the valve).

Flow Unit (R):

Data type: 16 bit integer
Description: The value indicates the selected engineering flow unit on the instrument. The table shows
the available values:

Value Unit
1 Scc/s
2 Scc/m
3 Scc/h
4 Ncc/s
5 Nce/m
6 Ncc/h
7 SCF/s
8 SCF/m
9 SCF/h
10 NM3/s
11 NM3/m
12 NM3/h
13 SM3/s
14 SM3/m
15 SM3/h
16 Sl/s
17 Sl/m
18 Sl/h
19 NI/s
20 NI/m
21 NI/h
22 a/s
23 g/m
24 g/h
25 Kgls
26 Kg/m
27 Kg/h
28 Lb/s
29 Lb/m
30 Lb/h
Set Point Source (RIW):

Data type: 16 bit integer

Description: Value indicates the source for the set point. The table shows the available values:

Value

Source

1

Digital (Profibus)

0 — 5 volts

0 - 10 volts

1 -5 volts

4-20 mA

OO [WIN

0—20 mA (SmartTrak 2 or higher)

13



CAUTION!
Select digital as source when the set point needs to be controlled through the network.
The other setting are for analog inputs on the DB15 connector

Gas Span (RIW):

Data type: 32 bit floating point (LSB — MSB)

Description: The gas span value allows you to linearly adjust the calibration of each available gas,
factory value is 1 and can range between 0.5 and 2.0.

Gas Index (R/W):
Data type: 16 bit integer
Description: Value shows which gas is selected on the instrument. Value can range between 1 and 10.

Zero Unit (RIW):
Data type: 16 bit integer

Description: Writing the value 0xADb to this register will set the zero the instrument (not available on
the SmartTrak 1). See the SmartTrak 2 manual for more information.

Factory Reset (R/W):

Data type: 16 bit integer

Description: Writing the value 0xAD5 to this register will reset all custom settings to factory defaults.
The zero value and gas span values are also reset.

Serial Number (R):
Data type: 16 bits ASCI|I
Description: Serial number of the instrument expressed as an eight character string.

Firmware Revision (R):
Data type: 32 bit floating point (LSB — MSB)
Description: Firmware revision number of the instrument.

Device Type (R):
Data type: 16 bit integer
Description: Number which represents the flow meter series (100 = 100S, 640 = 640S)

Status (R):

Data type: 16 bit integer
Description: Status indicates if the quality of the data in the registers (0 = bad, 1 = good).

14



Chapter 4: Sycon software

Sycon is a tool for the configuration of a Fieldbus network using a Hilscher CIF50-PB master. You
may be using a different configuration software and hardware Master, however, you will need to
accomplish the same functions. No specific slave DTMs of the Profibus DP are available.

Online diagnostic indicators and auto-scan function for the reading of network participants assist in the
commissioning of the network.

This guide will explain step by step how to configure the system to support various Profibus slaves on
a Hilscher CIF50-PB master.

Before starting make sure that the necessary device description files (GSD and bit maps) are available

in your device catalog. These are available on our web site.

Import Device Description (GSD) Files

In order to use a fieldbus device its properties need to be added to the CIF50-PB Master. This is done
by importing the device description files (GSD) into Sycon.

e Start Sycon and create a new document (File -> New)

A dialog window appears asking to select a fieldbus. For this example select Profibus:

AS-nterface
CAMNopen
DeviceMet
Ethernat / Protocal
InterBus

The main window is loaded. Go to the file menu and select “Copy GSD™:

15



P& SyCon - [Unnamed2]

Export

Copy G50

1 Unigate main board +0.9.pb
2 Testing 1005_EDS_2.dn

3 Master+sunigate, pb

4 Master+sunigate.pb

Exit

C Mew Chrim
—  Open... Chrl4+0
.{ Close
—  Save Chr4+S
Save As...

FEN Edit  View Insert ©Online Settings Tools Window Help

Copies a G5O file into the GSD directary

Locate the desired GSD file and load it. You will also be prompted to “import the corresponding
bitmap files”, click Yes. Load all 3 bitmap files. The GSD data is added to the Sycon library but it

PROFIBUS

isn’t available yet. Quit the program and restart it to refresh the catalog.

Configure A Slave

P& SyCon - [Unnamed2]
% File Edit ‘iew BiE

o= POD

Online  Settings  Tools  Window  Help

Predefined Slave...

Config Made

<:I Add master here

Inserts a new Master

Create A New Document And Insert A Master:

Place the master at the top of the line. A dialog window appears where a master needs to be selected

PROFIBLS

Config Mode

from a list. The list shows every type of master supported by Sycon. Select the Profibus master which
has been installed on the PC:

16



Insert Master.

Awalable mazters

CIF100-FE
CIF104-DP-AB

CIF104-Fr5

CIF104P-PE / CIF104C-FE
CIF20-DPM / CIF104-DPM /R
CIF30-FMS

CIF30-PE / CIF104-PB << Remove Al

|3

CIFS0-FB
CIFE0-FB << Bemove
CIFFS1-DPh

CICOC ChdC

|
[asRems |

54

Yendar name Hilzcher GrnbH
|dent number (x1645
G50 file narme  HIL_1B45.G5D

Selected masters

CIFS0-FE

Station addreszs

D'escription

—

Cancel

X

|Master[l

Board ID 1

Driver name 'CIF Device Driver'

Do wou wank to assign the hardware?

Auto Addressing

The master needs to be set to auto addressing.

Leave the station address set to zero. Press the “Add” button and then the “OK” button.

1. Click on the master and from the file menu select “Settings -> Master configuration”:

ES?CI:H - [1005 + 640S.pb]
?"E_: File Edit View Insert Online BEEGGEEN Tools  Window  Help

0|=|a| *|?]

Device Assignment. ..

Bus Parameter. .,
.| =l | Za| FOD

Master Settings...

Master Configuration. ..
Group Membership, ..

FMS Settings...

CtrHEB

-PE

2. Make sure the “Auto addressing” is checked:

A window pops up showing the driver linked to the selected master. Press “Yes” to use the hardware.

The configurator has detected a suitable hardware on your system,

Note: The board ID number changes when extra PCI cards are added to the PC. Older configurations
must be checked before trying to run them.

17



Master Configuration

General
Description |Master)
Cancel |
Station address | 0
Device CIFR0-FPB
DP Support

DPF Master Settings ... | v Auto addressing <:|

FtS Suppart
FMS Seftings | CRL .. |

Actual Master

Insert a Slave To The System

1. File menu: Insert -> Slave. Place it below the master:

PS SyCon - [Unnamed?]

'1_3 File Edit Wiew BGEEES Online  Settings Tools window  Help

D Bq. n Master...
.{w ”l‘- CZ FOD Communication Reference connection, .,

Predefined Slave. ..

«|E3

- Mastero
Station address ]
FM S0P Master CIFa0-PE

<:I Add slave here

2. Set the slave filter to “Sierra Instruments Inc.” Select the desired GSD file, press the “Add”
button, set the slave address and description to match the slave and press the “OK” button.

Insert Slave E|
Slave Filter
Yendor Siena Instruments Inc. Master |EI / CIF50-PE ﬂ
Slave type | Al j LCancel

Available zlaves Selected dlaves

100 Compod Profibus DF

Add >
Add Al >

<< Remove All

i

<< Bemove

Yendor name Siera Instruments Inc. Station address
Ident number 0<0E12

G50 file name SIEROE12GSD
G5D Revizion V1.0

Description |




Note: If no slave device appears in the window then the GSD file hasn’t been copied into the Sycon

catalog.

3. Double click on the added slave in the main window. The slave configuration window

appears:

Slave Configuration

3

General _
Device 100 Compod Profibuz DP Station address 1 | ak. |
Dezcription |Flnw_|:u:|ntmller1 Cancel |
[v Activate device in actual configuration
W Enable watchdog control GSDfle  SIERDE12.GSD Parameter Data.._|
baw. lenagth of in-/output data 70 Buyte Length of in-/output data 0 Byte D Settings... |
b aw. lenath of input data 46 Bute Length of input data 0 Bute Azsigned master
aw. length of output data 24 Buyte Lenath of output data 0 Byte | Station address 0
Max. number of modules 2 Mumber of modules 0 (Y p—
Module Inputs |Outputs/In/Out |Identifier Lt 0/ CIF50-FE ﬂ
Process, 32 bytes in, 24 3E Z4 axco, Ox37,
Dewvice info, 14 = 14 Ox40, OxS8D Al e
Station address 1
Flow_controller
| | 117100 Compod Profibus D v |

§lot|Idx [Module |Symbol |Type |I Addr. |I Len. |Type |0

Addr. |D Len. Append Module

]

Femove Module

Ingert Module

Predefined Modules

Symbolic Mames |

el

4. Select the desired modules by double clicking on the module name. Press the “OK” button.

Download Configuration
The configuration needs to be downloaded to the master (On

line -> Download):

= SyCon - [1005 flow controller. pb]
"% File Edit Wiew Insert

0| <

| la | T PO

Wl (BN Settings  Tools  Window  Help

Ctrl+D

Crii

Start Debug Mode

FMS Diagnostic. ..

Firmwate Download. ..

Image Download. ..

Firmware | Reset, ..

Extended Device Diagnostic,.. CErl+T
Global State Field...

Live List. .,

Ti0 Monitar. ..

Message Monitor, ..

FMS Monitar...

1]
v CIF50-PB

ontroller1
5 1
100 Compod Profibus DP

19



A pop-up may appear warning you that the communication may stop:

2

If the download is done during the bus operation, the communication between
the master and the slaves is stopped.
Do you really wank to download?

Press “Yes” to continue. The data is downloaded to the master:

= on - [100S flow controller.pb

%
0= ?
o e L

s —
!

Master0

Station address
FMEADP Master

0
CIF50-PB

Sitahion address
DF Slavie

7.
- lﬁ Flow_controller1
- 1

100 Compod Profious DP

Download Station Address 0

2

1
m:
o

Data baze 7005 flow controller. pb
Length of data base 3464
Errar 1]

0 NENNNNNENENENNNNENENENENNNNNENEEER

3080

When done save the new configuration to disk (File -> save as). Put the .pb file where your server can
get it later. The system is ready to be used.

20



Check The Configuration

To make sure things are working, start the debug mode:

E SyCon - [1005 flow controller. pb]

D= d| =2

o | = | S| PO

% File Edit Yiew Insert Relie

Download. ..

Start Debug Mode

FMS Diagnostic, ..

Firmware Download. ..
Image Download. ..
Firmware | Reset. ..

Extended Device Diagnostic. ..

Global State Field. ..
Live List...

1O Manitar. ..
Message Monitor ...
FMS Monitar,. .

Antamatic Metwork Scan

Settings  Tools  ‘Window Help

ChHD

ChrHT

D

& ]

¥ CIFE0-PE
ontroller1
& 1

100 Compod Profibus DF

If everything is working correctly then the line between the master and the slave will be green and the

bit map shows a green check:

] SyCon - [100S flow controller. pb]

lt_: File Edit Wiew Insert Online Settings Tools ‘Window Help

Dje{al x|e|

Master0

Station address
FMS/A0P Mastar

CIFa0-FB

Flow_controller1

Station adidress 1
DF Siave 100 Compod Profibus DP

Double click on the slave to see the diagnostic status:
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Diagnostic Station Address 1

Station Status 1 Station Status 2 Station Status 3 oK ‘
™ Master Lock | Slave Deactivated [~ Eut Diag Overflaw ‘
[~ Parameter Fault [ reserved [ reserved
LCompare Configuration ‘
I Irwvalid Slave Response [ Sync Mode I reserved
[~ Mot Supparted [ Freeze Mode [ reserved
| Extended Diag v ‘wiatchdog On I reserved
[ Configuration Fault v Slave Device [ reserved
[ Station Mot Ready [ Static Diag [ reserved
[ Station Mon Existent [ Parameter Req used [ reserved
Azzigned Maszter address 0 Real |dent Mumber O«0E12
G50 Ident Murmber O«0E12 Erar O

Press the “OK” button and leave the debug mode (Online -> Stop Debug Mode).

Should the line be red (error) then double click the slave to find out what the problem is:

L] SyCon - [100S flow controller.pb]

'1_= File Edit Yiew Insert Online Settings Tools ‘Window Help

D|{el |2

Master0
Station address i]
FMSAOP Master CIFA0-PE

Flow_controllert

Station address 2
DF Slave 100 Compod Profibus DP

The diagnostic window gives an indication of the problem:

Diagnostic Station Address 2

X

Station Status 1 Station Status 2 Station Status 3 oK. ‘
™ Master Lack v Slave Deactivated [~ Est Diag Overflow

[ Parameter Fault [ reserved [ reserved ‘
[ Irwvalid Slave Response [ Spnc Mode [ reserved ‘
[~ Mot Supported [ Freeze Mode [ reserved

[ Extended Diag [ watchdog On [ reserved

[ Configuration Fault [ Slave Device [ rezerved

[ Station Mot Beady [ Static Diag [ rezerved

| Station Mon Existent [ Parameter Req used [ reserved

Azzigned Mazter Address 0 Fieal dent Mumber Q0000
GSD Ident Mumber 0=0E12 Erar 0
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In this case the slave is deactivated. Check the address of “Slavel” to see if it matches with the
physical address of the hardware slave.

Correct any error. If the slave address in the configuration is incorrect, adjust it and download the
configuration again.

Kepserver OPC Software

You may be using different server software or a PLC. This example shows how to use the
KepserverEx (Legacy version) 4.0 free demo software on a windows PC. It can be downloaded at:
http://www.kepware.com/kepserverex/.

After you have installed the Kepserver software start a new project.

1. Click to add a channel.

KEPServerEx - [untitled.opf]

Ed View Users nols 2l
Nl - tB2RX | 20%E
P lick to add a channel. Tag Name I Address I Data Type l Scan Rate I Scaling
53 N
Date Time ] User Name Source J Event i~
02120)‘2013 1:36:10 PM Default User KEPServerEx TIWAY Host Adapter device driver loaded successful
€ 2/2012013 1:36:10 PM Default User KEPServerEx Triconex Ethernet device driver loaded successfully.
0212012013 1:36:10 PM Default User KEPServerEx Uni-Telway device driver loaded successfully.
€ 212012013 1:36:10 PM Default User KEPServerEx User Configurable Driver device driver loaded succes
02;'20!2013 1:36:10 PM Default User KEPServerEx Yaskawa Memobus Plus device driver loaded success o |
L ‘ | ¢
|Ready [Clients: 0 iActive tags: 0 of 0 Y

2. Give the channel a name. Click Next.

New Channel - Identification

& channel name can be from 1 to 256
characters in length.

[Names can not contain periods, double
quotations or start with an underscore.

Channel name:

profibus master

Bacl I Next > I Cancel Help



http://www.kepware.com/kepserverex/

3. Choose a Master, we are using a Hilscher CIF50 master. Click, Next.

annel - Device Driver @

Select the device driver you want to assign to
tthe channel.

‘The drop-down list below contains the names of
all the drivers that are installed on your system.

Device driver:

Hilscher U

™ Enable diagnostics

< Back I Next > I Cancel Help

4. The defaults will work, click Next.

annel - Write Optimizations @

You can control how the server processes wiites on
tthis channel. Set the optimization method and
Iwrite-to-read duty cycle below.

Note: Wiiting only the latest value can affect batch
|processing or the equivalent.
~ Optimization Method - —
 Wiite all values for all tags
" Write only latest value for non-boolean tags

" \Wiite only latest value for all tags

~ Duty Cycle -

Perform ]10 __J:' writes for every 1 read

< Back I Next > I Cancel Help

5. Chose the board and type, click next.

New Channel - Board Selection @

Select the board through which communications wil
joccur. To access data from a local slave board,
iselect the board corresponding to that slave and
'select the appropriate slave board type. Otherwise
iselect a local master board and type.

Board: Board 1 v

Type: IPlofibus DP Master « I

< Back | Next > I Cancel Help
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6. You’ll need to import the setup .pb file that we created earlier in Sycon. You may browse to
the location where you saved it. Click Next.

New Channel - SyCon Database Import @

'Set the location of the SyCon Configuration

D atabase file to be used in tag database creation.
The file's extension is representative of the fieldbus
lin question. For example, myconfig.dnis a
DeviceMet database.

Tag Import File:
lEnter or Browse for SyCon D atabase File E

Options I

< Back MNext > Cancel Help

7. Click OK.

Import Tags from SyCon Database
Look in: | (3 Sycon ~| & ek B9

.7 1005 flow controller.pb

& 1005_1 + 6405_2.pb
& 6405 Flowmeter.pb

File name: [1 00S flow controller
Files of type: ]SyCon ProfiBus Database [*.PB) LI Cancel |

¥ Open as read-only

“\\

You should see this warning.

KEPServerEx

! 5 'Synchronize' must be performed to synchronize with and regenerate tags based on the currently selected database.
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You can review the summary of the new channel you just created.

New Channel - Summary

If the following information is correct click 'Finish' to
save the settings for the new channel.

Name: profibus master
Device Driver: Hilscher Universal
Diagnhostics: Disabled

|24

‘wirite Optimization:
Wite only latest value for all tags
10 writes per read

Board Selection: Board 1
Board Type: Profibus DP Master

SyCon Database: C:\Documents and

(€

< Back | Finish I Cancel Help

8. You may now add your first slave device. Click on “Click to add a device”

< KEPServerEx - [untitled.opf *]

File Edit Yiew Users Tools Help
DEE LMo E o $REX AW ES
B profibus master Tag MName | address | pataType | ScanRate | Scaling
4l[l] Click to add a device.
< | 2>
Time | User Name Source | Event )
1:36:10 PM Default User KEPServerEx TIWAY Host Adapter device driver loaded successful
1:36:10 PM Default User KEPServerEx Triconex Ethernet device driver loaded successfully.
1:36:10 PM Default User KEPServerEx Uni-Telway device driver loaded successfully,
1:36:10 PM Default User KEPServerEx User Configurable Driver device driver loaded succes
1:36:10 PM Default User KEPServerEx YYaskawa Memobus Plus device driver loaded success « |
| >
(Clients: 0 |Active tags: 0 of 0 Y/
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9. Give your new device a hame.

New Device - Name @
& device name can be from 1 to 256 characters
in length.

[Names can not contain periods, double
quotations or start with an underscore.

Device name:
c100_1

Bach I Next > I Cancel Help

10. Set the device ID. ID# 0 was already used for the master, so chose #1.

New Device - ID %]

T he device you are defining may be multidiopped as
|part of a network of devices. In order to communicate
Iwith the device, it must be assigned a unique ID.

’Y our documentation for the device may refer to this as
|a "Network 1D or "Network Address."

Device ID:
=1 [Decimal -]

< Back I Next > I Cancel Help
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11. The next 2 screens will be fine as default, click next. Choose the device type. Click next.

New Device - Device Type @

Select a type that best describes the device you are
defining.

Type: Profibus DP Slave 4

< Back I Next > I Cancel Help

12. Review the new device summary, click next.

New Device - Summary @

If the following settings are correct click 'Finish' to beain
using the new device.

Name: C100_1 A
Model: Hilscher Universal -
1D: 1

Request Timeout: 2000 ms
Fail after 2 attempts

Auto-Demation: Disabled
Device Type: Profibus DP Slave

Channel Assignment: profibus master
Driver Name: Hilscher Universal

[£

< Back I Finish I Cancel Help

13. Click Finish, you have now created a new device for your network.

14. You will now need create a Tag to access each piece of Cyclic data, as specified in chapter
3.2. Click on “Click to add a static tag” and fill in the boxes as above.



Tag Properties @

General l Scaling |

~ |dentification

Name: IF|°W

Address: I’UDUS

Description: IHOW Rate

Data properties -

Data type:  |[FEES ¥

Client access: | Read Only |

Scan rate: |1DD ._l;] milliseconds

| oK I Cancel Apply Help

The example above is for the flow.

Flow (R):
Data type: 32 bit floating point (LSB — MSB)
Description: The actual flow as measured by the instrument

Because you only have one device on your network, and the Flow is the first data, the Address would
be 0. If there were other save devices in your network you would need to add the last Address of the
previous device to the starting address of the new device.

Add a tag name. Address 0 with the data type, in this case 10 D 0 S. (32 bit float, byte swapped). Add
a description. Set the Client access to Read Only. Click OK.

Kepserver has a very simple Quick Client that can be used to read and write to device tags. Click the
Hammer icon on the tool bar to start the quick client. When you highlight the “profibus
master.C100_1 tag”, you can read the flow data (4.756) and quality of the communications. You have
now successfully read the Flow data from the Smart Trak.

OPC Quick Client - Untitled * CEX
File Edit View Tools Help
DeEcce® &BEX
=) i} KEPware.KEPServerEx.v4 Item ID | Data Type l Value Timestamp | Quality ] Updat

@ system @profibus master.C100_1 Flow Float 4,756 14:02:57:625 Good 13
profibus master. _System

i== | profibus master.C100_1

profibus master.C100_1,_Systen
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GSD File Text And Cert

#Profibus_DP

’

; Sierra Instruments Inc.

; Version 1.0

’

; This GSD-File is intended for the SmartTrak mass flow meter

; This Unit support DPVO, DPV1

; History:

; V1.0 January 2012 Initial version

’

; Incoming cyclic data:

; Process data:

; Instance ID | Description | Size (bytes)
;1 | Flow | 4

;2 | Setpoint | 4

;3 | Valve mode | 2

;4 | Valve power | 2

;5 | User full scale | 4

;6 | Factory full scale | 4

;7 | Flow unit | 2

;8 | Setpoint source |2

;9 | Gas Span | 4

;10 | Gas Index | 2

;11 | Status |2

; Device Info:

; Instance ID | Description | Size (bytes)
;12 | Serial Number | 12

;13 | Device Type | 2

;14 | Firmware revision |4

; Outgoing Cyclic data (master to slave)

’

; Instance ID | Description | Size (bytes)
;15 | Setpoint | 4
;16 | Valve mode | 2
;17 | User full scale | 4
;18 | Flow unit | 2
;19 | Setpoint source | 2
;20 | Gas Span | 4
;21 | Gas Index | 2
;22 | Zero unit | 2
;23 | Factory reset |2
GSD_Revision =4

Vendor_Name
Model_Name
Revision
Ident_Number
Protocol_ldent
Station_Type
FMS_supp
Hardware_Release
Software_Release

’

9.6_supp

19.2_supp =1
45.45_supp =1
93.75_supp =1
187.5_supp =1
500_supp =1
1.5M_supp =1
3M_supp =1

="Sierra Instruments Inc."
="SmartTrak 100S - Profibus"

="V1.0"
=0x0el2
=0
=0
=0
="v1.2"
="V1.4"
=1

| Format

| REAL
| REAL
| INT
| INT
| REAL
| REAL
| INT
| INT
| REAL
| INT
| INT

| Format

| Ascll
| INT
| REAL

| Format

| REAL
| INT
| REAL
| INT
| INT
| REAL
| INT
| INT
| INT
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6M_supp
12M_supp

1
N

MaxTsdr_9.6 =60

MaxTsdr_19.2 =60
MaxTsdr_45.45 =60
MaxTsdr_93.75 =60
MaxTsdr_187.5 =60

MaxTsdr_500 =100
MaxTsdr_1.5M =150
MaxTsdr_3M =250
MaxTsdr_6M =450

MaxTsdr_12M =800

Redundancy =0

Repeater_Ctrl_Sig =0

24V_Pins =0
Implementation_Type = "VPC3+C"
Bitmap_Device ="100S_De"
Bitmap_Diag ="100S_Di"

Bitmap_SF ="100S_Sf"

Freeze_Mode_supp =1

Sync_Mode_supp =1
Auto_Baud_supp =1
Set_Slave_Add_supp =1
Min_Slave_lIntervall =1

Publisher_supp =0

Modular_Station =1

Max_Module =2
Max_Input_Len =46
Max_Output_Len =24
Max_Data_Len =70
Modul_Offset =0
Fail_Safe =0
Slave_Family =9

Max_Diag_Data_Len =11
I;DPV1_SIave =1
;C1_Read_Write_supp =0
;Max_Initiate_PDU_Length = 52

C2_Read_Write_supp =1
C2_Max_Data_Len =80
C2_Response_Timeout =300
C2_Read_Write_required = 1
C2_Max_Count_Channels =2

DPV1_Data_Types =0
Max_User_Prm_Data_Len =237
PrmText=1

Text(0)="disabled"
Text(1)="enabled"

EndPrmText

ExtUserPrmData=1 "DPV1mode"
Bit(7) 0 0-1

Prm_Text_Ref=1
EndExtUserPrmData

Ext_User_Prm_Data_Const(0) = 0x00,0x00,0x00

Ext_User_Prm_Data_Ref(0) =1

; <Module-Definition-List>

;depending from used Hardware (9..237)

Module ="Process,32 bytes in,24 bytes out" 0xc0,0x97,0x9f

1
EndModule

Module ="Device info, 14 bytes in" 0x40,0x8d

2
EndModule
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PROFIBUS Mutzerorganisation e,
Haid-und-Meu-5tr. 7

D-76131 Karlssuhe

Tel- +48-721-24 53-520

Fax: +42-721-06 53 580

E-mail: infoi@profibus. com FROFIFUS - PROFINET
hitpeiiwww. profibus.com

Confirmation
Registration of a PROFIBUS Device

Model name : 100 Compeod Profibus DP
Release - 1
Manufacturer : Sierra Instruments Inc.

The following details have been registered by PNO for the device mentioned above:

Device type: I Master ¥ Slave

Protocol type: ¥ DP-VD [ DP-Vi [ DP-\2
1D Number : 0E12 HEX

GSD file : SIERDE12.GSD

Contact person:

Siema Instruments Inc.

Mr. Evarnsto Westplate
Engineering

Bijlmansweid 2

1934RE Egmond aan den Hoef
MIEDERLAMDE

Tel: 31 7250 71400

Fax: 31 7250 71401

E-Mail: e_westplate{@siemainstruments.nl <“ //’ eég/
M. St

Karlsruhe, 2012-08-14
Flace, Diate Business affice of the PROFIBEUS Nutzerorganisation e V.

EFRIEIL
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